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Instrukcja Obsługi Platformy MetaTrader 5

MetaTrader 5 jest jedną z najpopularniejszych platform handlowych. Umożliwia 
traderom uzyskanie dostępu do rynku Forex, akcji i kontraktów terminowych. MT5 to 
uniwersalne narzędzie handlowe, które zapewnia funkcje niezbędne do udanego 
handlu. Platforma umożliwia użytkownikom przeprowadzenie analizy technicznej i 
fundamentalnej, oferuje możliwość automatycznego handlu i jest dostępna na 
urządzeniach mobilnych.

MetaTrader 5 w liczbach:


�

� 9 rodzajów zleceń�
� 82 narzędzia analityczne, w tym wskaźniki techniczne i obiekty graficzne�
� 21 ram czasowych�
� do 100 wykresów otwartych w tym samym czasie


Korzystając z platformy MT5, możesz cieszyć się pełną gamą aktywów oferowanych 
przez InstaForex, które obejmują prawie 3000 instrumentów: waluty fiducjarne, akcje 
amerykańskie i UE, indeksy, towary, kryptowaluty, fundusze ETF i SPAC.

Przygotowana przez nas instrukcja zawiera następujące zagadnienia:

�� Pierwsze kroki   �
�� Podstawowe pojęcia�
�� Narzędzia handlowe�
�� Składanie zleceń


www.instaforex.eu



�� Pierwsze kroki

Po pierwsze, zainstaluj MT5 na swoim komputerze lub urządzeniu mobilnym. Pobierz 
plik instalacyjny jednym kliknięciem na . Kliknij Trading Platform w 
górnym menu i wybierz MetaTrader 5. Następnie wybierz system operacyjny 
urządzenia. 


instaforex.eu

MT5 ma prosty i intuicyjny interfejs. Wszystkie niezbędne funkcje znajdują się w 
menu głównym. Pasek narzędzi zawiera najczęściej używane funkcje, które można 
dostosować. W tym celu kliknij prawym przyciskiem myszy pasek narzędzi i wybierz 
Customize.

Okno Market Watch po lewej stronie pokazuje cenę wszystkich dostępnych 
instrumentów handlowych, podczas gdy okno Navigator umożliwia zarządzanie 
narzędziami handlowymi do analizy technicznej. Okno Toolbox na dole zawiera 
informacje o stanie konta handlowego, statystyki handlowe, wiadomości z rynku, 
dziennik i inne ważne dane.





Dla wygody użytkowników wszystkie elementy interfejsu MT5 są w pełni 
konfigurowalne. Możesz zatem ukryć dowolne okno w razie potrzeby i skupić się na 
przykład na Głębokości Rynku.


Interfejs Platformy
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Po pierwszym uruchomieniu platformy zobaczysz wyskakujące okno, w którym 
możesz zarejestrować nowe konto lub zalogować się na istniejące. Insta Fintech Ltd. 
używa ustawień domyślnych, więc po prostu kliknij Next, aby kontynuować.

Możesz również zalogować się, klikając File -> Login to Trade Account. W 
wyskakującym oknie wprowadź numer konta i hasło i kliknij OK. 

Jak się zalogować?  
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Zlecenia, transakcje i pozycje są ze sobą powiązane. Na przykład decydujesz się na 
otwarcie długiej pozycji na parze EUR/USD, tzn. chcesz ją kupić. W takim przypadku 
musisz otworzyć długą pozycję, wysyłając odpowiednie zlecenie do swojego brokera. 
Później decydujesz się zwiększyć wolumen otwartej pozycji, więc otwierasz 
transakcję, co powoduje zwiększenie wolumenu Twojej pozycji.

MT5 obsługuje systemy rozliczania Netting i Hedging. W przypadku stosowania 
systemu Netting jedna wspólna pozycja odpowiada jednemu instrumentowi. Na 
przykład, jeśli masz pozycję kupna na parze EUR/USD, ale zdecydujesz się otworzyć 
transakcję sprzedaży, całkowity wolumen Twojej aktualnej pozycji zostanie 
zmniejszony. System Hedging pozwala na otwarcie kilku pozycji na jednym 
instrumencie, w tym pozycji przeciwnych. Wybór systemu zależy od strategii 
handlowej. 

System księgowania pozycji

MT5 obsługuje zlecenia rynkowe i oczekujące. Kiedy wysyłasz zlecenie rynkowe do 
brokera, Twoja transakcja jest realizowana zaraz po otrzymaniu tego zlecenia. 
Zlecenie oczekujące jest realizowane po spełnieniu określonych warunków. Dostępne 
są następujące rodzaje zleceń oczekujących:

Rodzaje zleceń

Zanim zaczniesz handlować, musisz zrozumieć kilka pojęć, które pomogą Ci 
skutecznie prowadzić operacje handlowe:

� Zlecenie (order) jest wysyłane do brokera w celu otwarcia transakcji (kupna lub 
sprzedaży). Istnieją zlecenia rynkowe, które są realizowane natychmiast i zlecenia 
oczekujące, które są realizowane, gdy spełnione zostaną określone warunki.�

� Transakcja jest operacją kupna lub sprzedaży instrumentu handlowego.�
� Pozycja odzwierciedla całkowitą liczbę kupionych lub sprzedanych kontraktów.

2. Podstawowe pojęcia

� Buy Limit - zlecenie zakupu po cenie Ask równej lub niższej niż określona w 
zleceniu�

� Buy Stop - zlecenie zakupu po cenie Ask równej lub wyższej niż określona w 
zleceniu�

� Sell Limit - zlecenie sprzedaży po cenie Bid równej lub wyższej niż określona w 
zleceniu
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Status zlecenia może być następujący:

Informacje o wszystkich zrealizowanych zleceniach są dostępne w zakładce History 
w oknie Toolbox. Aby sprawdzić status zlecenia oczekującego, przejdź do zakładki 
Trade. 

� Uruchomione — zlecenie zostało złożone, ale dealer jeszcze go nie przyjął�
� Złożone — zlecenie zostało przyjęte przez dealera�
� Częściowo zrealizowane — zlecenie zostało zrealizowane częściowo�
� Zrealizowane — zlecenie zostało zrealizowane całkowicie�
� Anulowane — zlecenie zostało anulowane przez Klienta�
� Odrzucone — zlecenie zostało odrzucone przez dealera�
� Wygasłe — zlecenie wygasło


Status zlecenia

Istnieją również zlecenia Stop Loss i Take Profit. Pierwsze z nich ma na celu 
ograniczenie strat i jest uruchamiane w celu całkowitego zamknięcia pozycji, gdy 
tylko cena osiągnie określony poziom. Zlecenie Take Profit działa w ten sam sposób, 
ale służy do realizacji zysku. 

� Sell Stop -  zlecenie sprzedaży po cenie Bid równej lub niższej niż określona w 
zleceniu�

� Buy Stop Limit - połączenie zleceń Buy Limit i Buy Stop, służy do złożenia zlecenia 
Buy Limit, gdy tylko cena Ask osiągnie wcześniej określony poziom�

� Sell Stop Limit - połączenie zleceń Sell Limit i Sell Stop, służy do złożenia zlecenia, 
gdy tylko cena Bid osiągnie wcześniej określony poziom
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3. Narzędzia handlowe

Okno Głębokość Rynku (DOM) 
wyświetla aktualne zestawienie 
cen BID i ASK. Aby otworzyć 
DOM, kliknij prawym przyciskiem 
myszy potrzebny instrument 
handlowy w oknie Market Watch 
i wybierz Depth of Market, albo 
naciśnij Alt + B. Możesz kupić 
lub sprzedać instrument, klikając 
odpowiedni przycisk.

Głębokość Rynku

W MT5 możesz korzystać z handlu algorytmicznego, tj. zainstalować Expert Advisor, 
który jest oprogramowaniem automatycznie otwierającym i zamykającym transakcje 
za pomocą specjalnego algorytmu. Na platformie MT5 dostępne są wbudowane 
programy, takie jak ExpertMACD lub ExpertMAMA, lub możesz importować 
zewnętrzne oprogramowania EA.

Expert Advisor

Ostrzeżenie o ryzyku: handel algorytmiczny wiąże się z wysokim ryzykiem 
poniesienia straty. Powinieneś używać oprogramowania Expert Advisor 
wyłącznie z zaufanych źródeł.
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Aby włączyć handel algorytmiczny, kliknij przycisk Algo Trading w górnym menu.

Aby zarządzać oprogramowaniem Expert Advisor, przejdź do Tools -> Options i 
otwórz zakładkę Expert Advisors.

www.instaforex.eu



Okno Market Watch zawiera ceny, statystyki cen i wykresy tickowe. Aby dodać/
usunąć instrument, otwórz okno konfiguracji, klikając prawym przyciskiem myszy 
dowolny instrument. W wyskakującym oknie wybierz instrumenty, które chcesz dodać 
do listy Market Watch i kliknij Show Symbol.

Market Watch

Jeśli dwukrotnie klikniesz na instrument, otworzy 
się okno do otwarcia nowej pozycji. Aby otworzyć 
wykres instrumentu, przeciągnij go i upuść na 
obszar wyświetlania wykresu. Jeśli przytrzymasz 
Ctrl podczas przeciągania, wykres zostanie 
otwarty w nowym oknie. Nowe kolumny można 
dodać w oknie konfiguracji. Instrumenty można 
sortować, klikając odpowiednią kolumnę.





Aby zobaczyć statystyki dotyczące konkretnego 
instrumentu, wybierz go i otwórz zakładkę Details.
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Otwarcie transakcji jest możliwe za pomocą 
jednego kliknięcia w zakładce Trading w oknie 
Market Watch.

Handel Jednym Kliknięciem

Jednak ta funkcja będzie działać tylko wtedy, gdy włączysz ją w oknie Options. W 
górnym menu kliknij Tools -> Options. 

Ważne! Przed zaznaczeniem pola należy uważnie przeczytać klauzulę wyłączenia 
odpowiedzialności.
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Zarówno wskaźniki, jak i narzędzia Expert Advisors znajdziesz w oknie Navitagor. Dla 
wygody wskaźniki techniczne są podzielone na grupy. Aby uruchomić wskaźnik, po 
prostu przeciągnij go z okna Navigator i upuść na odpowiednim wykresie. Po 
wykonaniu tej czynności zobaczysz okno konfiguracji:

Ważne: upewnij się, że importujesz oprogramowanie z zaufanego źródła.

MetaTrader 5 ma 38 wbudowanych wskaźników technicznych i 4 narzędzia Expert 
Advisor. Poza tym możesz dodać nieograniczoną liczbę wskaźników 
niestandardowych lub EA.

Jak dodać wskaźnik lub EA do wykresu

Tutaj możesz ustawić 
niezbędne parametry, 
takie jak okres, kolor, 
poziomy, skala itp.

Proces dodawania narzędzia Expert Advisor do wykresu jest podobny: przeciągnij go i 
upuść lub kliknij prawym przyciskiem myszy i wybierz Attach to Chart. Co ważne, 
MT5 oferuje możliwość testowania, dzięki czemu możesz sprawdzić działanie 
narzędzia Expert Advisor przed jego uruchomieniem. Aby uruchomić okno Strategy 
Tester, kliknij prawym przyciskiem myszy na EA i wybierz Test. 

Aby włączyć Expert Advisor, kliknij przycisk Algo Trading w menu paska narzędzi.
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Jak już wspomniano, MT5 obsługuje zlecenia rynkowe i oczekujące. Dlatego, aby 
otworzyć pozycję, tj. kupić lub sprzedać określoną ilość instrumentu handlowego, 
możesz złożyć zlecenie rynkowe, aby Twoja transakcja została zrealizowana 
natychmiast. Jeśli złożysz zlecenie oczekujące, pozycja zostanie otwarta po 
uruchomieniu zlecenia. 



Istnieje kilka sposobów otwarcia okna dialogowego do składania zlecenia:


Po wykonaniu którejkolwiek z tych czynności zobaczysz następujące okno:

� Instrument (Symbol) — instrument handlowy, który zamierzasz kupić lub sprzedać�
� Rodzaj (Type) — rodzaj realizacji zlecenia (Rynkowy(Market) lub Oczekujący(Pending))�
� Wolumen (Volume) — wolumen transakcji na instrumencie handlowym, który chcesz kupić 

lub sprzedać, wyrażony w lotach. Minimalny wolumen w InstaForex wynosi 0,01 lota. �
� Stop Loss/Take Profit — poziomy, na których chcesz uruchomić zlecenia Stop Loss lub 

Take Profit. Możesz zostawić te pola puste, jeśli nie chcesz ustawiać S/L lub T/P.�
� Komentarz (Comment) — wszelkie komentarze dotyczące Twojej pozycji o długości do 31 

znaków. Komentarz pojawi się na liście otwartych pozycji i historii transakcji. To pole jest 
opcjonalne. 


� Kliknij prawym przyciskiem myszy na instrument w oknie Market Watch i 
wybierz New Order.�

� Kliknij New Order na pasku Standard toolbar lub wybierz Tools -> New Order.�
� Naciśnij klawisz F9.


4. Składanie zleceń

W tym oknie możesz ustawić parametry zlecenia:

Po ustawieniu powyższych parametrów kliknij przycisk Sell lub Buy. Następnie pojawi 
się okno potwierdzające zlecenie lub wskazujące powód, dla którego nie zostało ono 
zrealizowane. 
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Po otwarciu pozycji musisz obserwować jej wyniki i mieć ją pod kontrolą. Listę 
aktualnie otwartych pozycji znajdziesz w zakładce Trading w oknie Toolbox.

Ta zakładka zawiera informacje o instrumencie handlowym, rodzaju, wolumenie, 
cenie, aktualnym poziomie T/L i S/L (jeśli ustawiłeś) oraz zysku. Dodatkowo, obecne 
saldo i łączny wynik wszystkich otwartych pozycji znajdziesz tutaj.



Zakładka Exposure pokazuje zestawienie wszystkich otwartych pozycji i stan konta.


Aby zmienić lub usunąć swoją pozycję, kliknij zakładkę Trade i wybierz "Modify or 
delete". W wyskakującym oknie ustaw nowe poziomy T/P i S/L lub zmień istniejące. 

Zarządzanie Twoimi pozycjami
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Należy pamiętać, że przycisk Modify jest aktywny tylko wtedy, gdy poziomy Stop 
Loss i Take Profit są ustawione poprawnie.

Aby zamknąć pozycję, kliknij dwukrotnie. Możesz całkowicie zamknąć swoją pozycję 
lub tylko jej część, wybierając odpowiedni wolumen.



Jeśli wybierzesz "Close" w menu kontekstowym pozycji, zostanie ona natychmiast 
całkowicie zamknięta. 


Jak już wiesz, Stop Loss ma na celu zminimalizowanie strat. Uruchamia się, jeśli cena 
idzie w złym kierunku i zamyka pozycję na zadanym poziomie. Jeśli pozycja staje się 
opłacalna, Stop Loss powinien zostać przeniesiony do progu rentowności. Trailing 
Stop robi to automatycznie. Przesuwa Stop Loss na niezbędną odległość.

Aby ustawić Trailing Stop, znajdź 
odpowiednią funkcję w menu 
kontekstowym pozycji (kliknij ją 
prawym przyciskiem myszy w 
zakładce Trade).

Co to jest Trailing Stop i jak go zastosować
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MetaTrader 5 oferuje wszystko, aby zapewnić wygodną i wydajną pracę na rynkach 
finansowych. Teraz wiesz, jak korzystać z funkcji tej platformy. Aby zapewnić płynne 
działanie platformy, miej ją zawsze pod ręką. 

Wyłączenie Odpowiedzialności: 



Handel na rynkach finansowych ma charakter wysoce spekulacyjny i wiąże się 
z ryzykiem utraty pieniędzy. Inwestuj pieniądze, na których utratę możesz sobie 
pozwolić.



Wyniki z przeszłości nie stanowią gwarancji osiągnięcia podobnych wyników w 
przyszłości. Treści te są udostępniane wyłącznie w celach edukacyjnych oraz 
marketingowych i nie stanowią porady inwestycyjnej.



Kontrakty CFD są złożonymi instrumentami i wiążą się z wysokim ryzykiem 
szybkiej utraty pieniędzy z powodu dźwigni finansowej. 71,05% rachunków 
inwestorów detalicznych traci pieniądze podczas handlu kontraktami CFD z 
tym dostawcą.



Zastanów się, czy rozumiesz, jak działają kontrakty CFD i czy możesz pozwolić 
sobie na wysokie ryzyko utraty pieniędzy. 

Podsumowanie
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